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Getting Additional Information

In addition to the information contained in this manual, you may receive additional assistance in
using this product from the following sources:

Help Files / Release Notes

Many Bristol software products incorporate help screens. In addition, the software typically
includes a ‘read me’ release notes file detailing new features in the product, as well as other
information which was available too late for inclusion in the manual.

Contacting Bristol Directly

The address for our world headquarters is:

Bristol, Inc.

a division of Emerson Process Management
1100 Buckingham Street

Watertown, Connecticut 06795 USA

Our main phone numbers are:

(860) 945-2200
(860) 945-2213 (FAX)

Regular office hours are Monday through Friday, 8:00AM to 4:30PM Eastern Time, excluding
holidays, and scheduled factory shutdowns. During other hours, callers may leave messages
using Bristol's voice mail system.

Telephone / E-Mail Support - Technical Questions

During regular business hours, Bristol's Application Support Group can provide telephone/e-mail
support for your technical questions.
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Please refer to the table, below, for a list of products, and their associated technical support
contact information:

Product Support Phone E-Mail Address:

Number(s):
ControlWave series (hardware and (860) 945-2394 | bsupport@bristolbabcock.com
software) (860) 945-2286
Network 3000 hardware except for (860) 945-2502 | bsupport@bristolbabcock.com
TeleFlow series
TeleFlow series (3530-xx) (860) 945-8604. | bsupport@bristolbabcock.com
ACCOL, Open BSI, UQI, all other (860) 945-2286 | bsupport@bristolbabcock.com
software except for ControlWave and OE.
OpenEnterprise (OE) software (860) 945-3865 | scada@bristolbabcock.com
Radio telemetry services (interfacing (407) 629-9463 | bsupport@bristolbabcock.com
Bristol hardware to radios) (407) 629-9464.

Non-Technical Questions, Product Orders, etc.

Questions of a non-technical nature (product orders, literature requests, price and delivery
information, etc.) should be directed to the nearest Bristol sales office or to your Bristol-
authorized sales representative. Please call the main Bristol number (860-945-2200) or visit our
web site, listed below, if you are unsure which office covers your particular area.

Visit our Site on the World Wide Web

For general information about Bristol, Inc. and its products, please visit our site on the World
Wide Web at: www.EmersonProcess.com/Bristol

Training Courses

Bristol's Training Department offers a wide variety of courses in Bristol hardware and software
at our Watertown, Connecticut headquarters, and at selected Bristol regional offices, throughout
the year. Contact our Training Department at (860) 945-2343 for course information, enrollment,
pricing, and schedules.
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Who Should Read This Document?

This document is intended to be read by a Programmer or System Engineer who will be
configuring calculations that are to be stored in the OpenEnterprise Database.

This document assumes familiarity with the following subjects:
e ControlWave Designer

e OpenEnterprise Database Explorer / Database Object Viewer
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What is the Virtual ControlWave?

The Virtual ControlWave is essentially a ‘software’ version of the ControlWave controller that
exists on your PC, instead of in a separate piece of hardware. It can do much of what a regular
ControlWave can do, however, it has no I/O hardware, and like the ControlWave Designer 1/0
Simulator, it cannot store historical data (audit/archive) or run custom communication protocols.
It can, however, communicate with the OpenEnterprise Database.

The Virtual ControlWave includes a set of tools that allow you to take real-time signals from the
OpenEnterprise Database and bring them into a ControlWave Designer project. Once in
ControlWave Designer, calculations can be created using those signals. The project may then be
compiled and downloaded into the Virtual ControlWave, where it runs like any other project.
The results of the calculations are then stored back in the OpenEnterprise Database.

This mechanism allows you to perform extensive calculations using any ACCOL Il or IEC
61131 functions and function blocks. This can be used, for example, to do gas calculations, on
data from multiple RTUs, which would have been beyond the scope of the OpenEnterprise
Calculation Server.

There are three main parts to the Virtual ControlWave:

e Virtual ControlWave Configuration Tool — Allows you to identify which signals from the
OE Database will be used in the Virtual ControlWave.

e Virtual Controlwave Statistics Tool — Displays current values of variables updated via the
Virtual ControlWave.

e Virtual ControlWave — The actual soft-ControlWave.

Before You Begin

In order to use the Virtual ControlWave, you must have the following software installed and
running:

e ControlWave Designer (Project used must include the IPC_40 resource)

e OpenEnterprise Server Version 2.53 Service Pack 1 (or newer). The OpenEnterprise
Database must be configured and running. NOTE: If you have Version 2.53 without
Service Pack 1, you must manually start Polyhedra DDE software for the Virtual
ControlWave Configuration Tool to function properly.

e OpenEnterprise OPC Server must be running, if not running automatically.

e Virtual ControlWave Software, including configuration tools.
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Setting Up an IPC 40 Resource in your ControlWave Designer Project

The Virtual ControlWave can only run in conjunction with a project that has an IPC_40
resource.

Setting Up an IPC 40 Resource for an All-New Project: Double-click on "ControlWave"
: .
If you are creating an all-new ControlWave project, an _

IPC_40 resource is automatically added to your project by
simply selecting the ‘ControlWave’ template. (Don’t choose
‘CWMicro’ because it doesn’t use the IPC_40 resource.)

Project Wizard (RSt Ee e

Setting Up IPC 40 for an Existing Project:

If you have an existing ControlWave project that was NOT created with the IPC_40 resource, for
example, it was created using the *CWMicro’ template, you can add an IPC_40 resource to the
project in addition to the other resource you already have defined.

Right-click on 'Physical
Hardware' and choose
Insert->Configuration

1. First, right-click on ‘Physical Hardware’, and choose
Insert->Configuration from the pop-up menus.

Description worksheet

Enter a name for the configuration here.
We called it 'VIRT_CW:' for Virtual Control-
wave, but any valid name (no spaces) is

2. Inthe Insert dialog box, enter a name for the okay.
configuration, then select ‘IPC_40’ for the “PLC EF%
type”, then click on [OK]. MRT_CWf £ Cofguaion

| Besource
) Tash
I j € Biogram instarice

Program type:

' Description
PLCt o
pe € Yariables
€ FRiinstance

[IPc_s0 =l

- Mode:
© Insert
& fppend

/ 1
You must choose 'lPC_40' Click on [OK]
as the "PLC type". when finished.

Exclude from compilatian

Right-click on the icon that
was just created, and choose

Insert->Resource.
3. Now, right-click on the icon that was just created, and & ezEGSn =_=
choose Insert->Resource from the pop-up menu. ;
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4. Next, enter a name for the resource,
and choose ‘ControlWave’ as the
“Processor type”. Click on [OK]
when finished.

5. You should now create a task and
program as you normally would. If
you’re not sure how to do that,
please see the manual Getting
Started with ControlWave Designer
(document# D5085).

6. Itis important that you specify the
correct settings for the resource, or
the Virtual ControlWave will not
function correctly. Right-click on
the resource to bring up the
Resource Settings dialog box.

e You must choose “DLL” for the
port.

e The DLL must be “TCP/IP’.

e The IP address parameter must
be set to “127.0.0.1” because that
address will maintain IP
transmissions within the PC
(which is where the Virtual
ControlWave resides).

Click on [OK] when finished.

Enter a name for the resource here.
X|
|[Z\l\.-"ave| = Bt Cancel
i {*' Resource
. i L
I j € Progam instar Help | N
o
Processor type: o
[Control\:\u"ave j =
o
I/ Exclude from compilation

The "Processor type" must be Control\Wave.

You must choose "TCP/IP'.
Select "DLL".

x|
:
€ COML Cancel I
" COM2
" COM3 Data aiga... I
" COM4
" Simulation 1 Help |
" Simulatiop
ray boundary check on PLC
& Bl Force BOOLS for boolean variables
™ Generate bootproject during compile
DLL: _'_J

~0PC

¥ Al global variables

™ Marked vaiiables

" Marked POUs " Noreserve

Click on
[OK] when
finished.

\;ou must use an address
of '127.0.0.1".
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Using the Virtual ControlWave

A Simple Example - Using Virtual ControlWave to Perform a Calculation Using
Flow Totals From Two Different RTUSs.

Let’s say we have two RTUs called JOLIET_DRIVE and RIVER_ROAD that both feed data
into the OE Database. Each has a flow meter, and we want to combine the flow meter readings
from the two RTUs into a single value, representing the total flow. Here’s one way we could do
it:

1. Start the SQL Client, and create a local signal in the OE Database that will be used to hold
the result of the flow calculation, named TOTAL_FLOW. To do this, you need to run the
following SQL statements in the SQL Client:

insert into localrealanalog (name,regionname,devicename) values
("TOTAL_FLOW®,"","");
commit;

NOTE: For more information on local signals, see ‘Appendix A - Creating Local
Signals’.

2. Start the OpenEnterprise Database Explorer, and call up the table or view that contains the
data that will be used in your calculations. The data will appear within the Database Object
Viewer. For this particular example, you would want the ‘Realanalog’ view, but any table
can be used depending upon the needs of your calculation.

3. Start ControlWave Designer, and open the ControlWave Designer project in which you want
to perform calculations.

Choose the IPC40 resource you

added earlier. Do NOT choose

'CWNMicro' because it is NOT IPC40.

4. Start the Virtual ControlWave Configuration
Tool by clicking on Online - Virtual
ControlWave Config, within ControlWave
Designer.

~ Select a Configuration and a Resource:

5. If your project contains more than one
resource, you will be prompted to select the
configuration and resource that will be used
by the Virtual ControlWave. This resource

must use IPC_40. = |

Cwave_Micro

6. Drag each object you want to use in your calculation (it could be a signal value, an inhibit
status, etc.) from the Database Object Viewer into the Virtual ControlWave Configuration
Tool window. In this case, those signals would be:
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RIVER_ROAD:@GV. STATION_FLOW1

and
JOLIET_DRIVE:@GV._STATION_FLOW?2
plus the TOTAL_FLOW signal we created in Step 1.

NOTE: This essentially copies an OPC Tag that will be used to establish a link between
the OE Database, and your ControlWave project.

JJCWHOEAWCMIM onfige
File Edit View Variable Help

Fle Options Que ol

LB RBEHE e 2 g\ | Dirag tags from Database Explarer into the box below.
Tables ] Conditions | Parameters i Jons | Attrbutes | OFC... | Database Name 1131 Name T

| e il t Bristo.. JOLIET_DRIVE:@.. JD_FLOW?Z
0 4 Brsto.. RIWER_ROAD:@.. RR_FLOW1 REAL

0 4 Brsto.. TOTAL_FLOW.val. TOTAL_FLOW REAL

LAY

. / [ Dr_ag the o_bjects you wanft

to include in your calculations
from the Database Object
Viewer into the Virtual
ControlWave Configuration

—|| | Tool.

Once you have brought a particular object into the Virtual ControlWave Configuration Tool, you
can optionally rename it. This might be necessary, for example, if you are collecting the same
signal from multiple RTUs and you need to prevent duplicate names in your ControlWave
project. To rename a signal, simply double-click on it and the Edit Variable dialog box will
appear. The full OPC tag name is displayed in the window. Enter the new name in the “Variable
Name” field. You can also specify whether the variable will serve as an input to function

blocks/functions or as an output from them, by selecting either “Input” or “Output”. Click on
[OK] when finished.

For our example, we have re-named RIVER_ROAD:@GV._STATION_FLOW1 to
RR_FLOW1 and JOLIET_DRIVE:@GV._STATION_FLOW?2 to JD_FLOW?2.
TOTAL_FLOW we named TOTAL_FLOW. You should also note that TOTAL_FLOW
must be made an “Output” and the other two signals must be made “Inputs”.
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You can enter a new name
for the variable, here.

If the variable
serves as an
input to functions
and function blocks,  r guay
choose “Input”. If

it serves as an
“Output” from them,
choose “Output”.

Edit Variable

|HF|_FLDW1

oo [ Lol

BristalBabcock. BristalJPCS erver 'ttrdb1". 'realanalag”. "name: charRIY
ER_RO&AD:EGY._STATION_FLOW1"."value:float”

A

I-/|ere is the full OPC tag from
the OpenEnterprise Database.

7. Once you have renamed the signals, and set their input/output type as desired, you can save
them to your ControlWave project by clicking on File = Save in the Virtual ControlWave
Configuration Tool. This will create a VCWAVE_VARIABLES group in the global
variables worksheet of the currently open ControlWave project.

To access these new variables make sure you select the
VCWAVE_VARIABLES section which is in the Global Variables

worksheet under the resource you selected earlier.

=15 x|
3 Fle Edit View Project Buld Layout Onine Extras Window 2 ;|i|5||
DEHRE|s B2 |@a[BERaBEs ||[cax (s = |hEW
nnaa|lan |wronaa || me|s ||l o n b o] e

5 ControlWave Designer - CWV_ONE - [Global_Variables:VIRT_CW.CWave]

o ocmewee . & Noge” [ Twe | Usage |Descw
[T SIMPLET = Default
: SIMPLEV [l VCWAVE_VARIABLES
[ svFLE JD_FLOWZ REAL VAR_GLOBAL
53-8 Fhysical Hardwars RR_FLOW1 REAL VAR_GLOBAL
TOTAL_FLOW REAL WAR_GLOBAL

E@ VIRT_CW : IPC_40
| B-88 CWave : ControlWave®
i B3] Tasks
| 2@ T ovele
“[0] P1:SIMPLE
L i‘rj Global_Variables®
= I

TR R
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8. Scroll to the right in the Global Variable Worksheet to the PDD and OPC columns, then left-
click once on the header of the PDD column. This should select all the rows, as shown,
below:

Click here
=i ControlWave Designer - WRITE_MIX - [Global_Variables:ControlWawve.RTU_RESOURCE] = ||=)[*]
File Edit Yiew Project Build Layout ©Oplne Extras Window 2 =2 X
0 =& & & =l =Y = iz < [
40 %) &)
== Project : WRITE_MI% Name |Descripliun Address Iriit ‘ Fielain [FOD} OPC| A5
(03 Libraries | vtime_g4_out %GESS11E = r
[ Data Types | time_85_out %CES5204 | r
+ (3 Logical POUs | vtime_s6_out H%ERS5292 [ r
88 Physical Hardware | vtime_87_out %EB35350 Id r
=8 Cortrolwave : IPC_40 __|vtime_88_out #@BS5468E o r
=88] RTU_RESOURCE | vtime_g9_out %CES5556 I r
5 | vtime_8_out %0B55644 4 r
47y Global Variable | vtime_90_out #EBSST32 Id r
10 Configuratic | vtime_51_out %GE55620 I r
| vtime_g2_out %0B55908 2 r
| vtime_83_aut %QB55396 4 r
| vtime_94_out %EB5E054 Icd r
| vtime_95_out Q56172 I r
wtime_96_out WEBSE260 I3 r
| time_97_out %0B5E348 2 r
wtime_98_out %EB5E436 Icd r
| vtime_29_out HQB5E524 I r
| vtime_9_out W EBSEE1 2 I3 r
| vtime_synch_out 2%QBSE700 2 r
| werite_all_in AR I r
| » | write_etig_in %lHE9 ~ r
werite_dlint_in %190 2 r
ﬁl! [ EEI J _|write_irt_in EARG] I r
| | |wtite_realin a2 I r
| werite_str_in YalX93 I r
werite_time_in %lH 94 2 r
| ElAutolnsert from library '
Mame Descriptionl ad TIME AL r M =
E 3 F!rmware FB . E < e
3B Firrnweare: functions | = —
o Feyword v Global Waria...
T
f | ariabls | Walue = |. Wariable
bPass e =
FETEH STATL 77
Watch 1 A Watch 2 }, Watch Build £ Errars i Wamings A Infos A PLC Errars A Print 7
For Help, press F1 C: >2GE

7 Virtual ControlWave User Manual



9. Right-click on any individual PDD checkbox and choose “Properties” from the pop-up
menu.

fﬂ ControlWave Designer, - WRITE_MIX - [Global_Variables:ControlWave.RTU_RESOURCE]

File Edit View Project Buid Layout ©Online Extras ‘window 7 — ﬁ
0= B&| & iei=IENT] =Y =] ] = fH
40 ) &)
= 3 Frofct - WRITE_MN Name [Desciption Address Il | Retain o[~
+-(1] Libraries | vtime_84_out E2C ] p————. - F
+-( Data Tupes || vtime_85_owt %EE55204
+-(3 Logical POUs | vtime_o5_out %QESSIAT ;;:a::d":ar::‘::a“' r
=-§a Physical Hardware | wtime_87_out HAB55350 r
=8 Controbwave : IPC_40 _|vtime &5 _out %GB55458 . [
-G RTU_RESOURCE | viime_s9_awt wopsssss |  Delete warisble/group [mi
=l Tasks I vtine_8 ot HIBEEAL | piapicfenable variable r
f"D Global_Variable | wtime_90_out WAB55732 r
|0_Configuratic | wtime_91_out HEB55320 Cut r
| wtime_92_out YEB55508 Copy [m]
| vtime_93_out %OB55I96 [mj
wtime_94_out %QB5E054 [mj
| +time_55_out soBsei7z|  Fiter settings.. [
|| wtime_96_out wopseoen|  Fier [m]
| |vtime_a7_out oBsEI4E | Sort L4 O
wtime_86_out %OB5E36 [mj
— Open inskance...
| vtime_85_out %OB5E524 [mj
| vtime_8_out %OBSEE12 [mj
| vtime_synch_out %0BSET00 v [m]
| write_all_in EANEES I [m]
| write_dig_in EANEE] I [m]
| write_dint_in EAPEn] I [m]
| write_int_in EANEI I [m]
| |write_real_in %IH2 I [m]
| write_str_in EANEE] I [m]
werite_time_in EANCES I [m]
| & Awutolnsert from library '

e [Dossrpion] @ | [_ImHe_veL O A
3 Firmware FB = B
B Firrnvware functions = =
& Keyword P Global Yaria..

T
= | ariable: | Walug =
bPass e
FETCH_STATL 777 -
k[ Watch 1 Am Build A Errors A Warnings A Infos A PLC Errors A Print
Ci >2GE
Properties [5_(|

10. In the Properties dialog box, select both the | [=™=

PDD and OPC boxes and click on [OK]. | _ Cocdl |

Uzage:

[ RETAIN
Help
Data Type: 4
| [~

Initial walue:

140 address:

Description;

v POD v OPC
ad

Check these two boxes.
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This should mark all global variables as PDD and OPC.

#f ControlWave Designer - READ_DIG - [Global Variables:ControlWave. RTU_RESOURCE]

File Edit Wew Project Build Layout Opline Extras Window 7 = ﬁ
=2 & + B hai=]EE ) == i % FH
il &)
Name Address Int | Retain | PDD| OPC| -
-8 Physical Hardware | 5 VCWAVE_VARIABLES =
=58 Controlwave : IPC_40 _|read dig_resutt_out B0 I Il
-8 RTU_RESOURCE : Con | |read_dig_sych_in IXD [
588 Tasks _|vdig_1000_in HIH1 2 F
[ COLD : SYSTEH | |vdig_1001_in %IX2 vV [V ¥
-] T1:cveuc | vdlig_1002_in KT 72 V¥ W
[0] READ_DIG | vdlig_1003_in Bl 2 ¥ W
5 Global Variables | |vdlig_1004_in HIHS vV v ¥
10_Configuration 4| | vdlig 10035 _in IxE e vV~
q | | D |— | vdlig_1008_in KT I~ ¥ v
= = | vdlig_1007_in %lx3 I Vv ¥
& @E | |vdig_1008_in %IXS F [F ¥
|vdig_1009_in %110 2 F
| _|wdig_100_in LK1 | ¥V~
| |vdig_1010_n K12 ¥V [V~
_|vdlig_1011 _in IS I ¥ v
— velig_1012_in %14 F |[F F
| Des_°_”"“°” [& | |wdig_1013_n %15 F | F F
|ADD Addiion " |vdg_1014_n LR ¥V ¥ ¥
WAND  Bitwise AND | |vdig 1015 0n BT 7 F |[F ¥
FCTD Counter Down ) " |vdg_1016in %IK15 ¥V [F V¥
& CTU Counter Up " |vdg_ 1017 n %1H19 F | F F
WCTUD  Counter Up/Down _|vdig_1019_in %120 Ird F ~
E Y Division | |vdig_1019_n %21 ¥V ¥ 2
WED Equal: = ¢ = - I3
- F TRIG Faling Edge Detection L =
1 GE Greater Than Equal »= v Global Varia...
Build £ Errars i Wamings f, Infos f, PLC Erors f Print /
For Help, press F1 112002 T »2GE
11. Re-compile the project once again by clicking on Build - Make.
ch File > S All Specify the correct variable section when
12. oose File ave . you want to select one of the Virtual ControlWave
variables.
Variable Properties x
. Hame S |
13. You can now use these variables as S el [ o .
you would any other variables in your ’%’-@b e (==
. . TOTAL FLOW
ControlWave Designer project. When  .urm [peian e
selecting them in ControlWave fowT I | smdvitere
. o] Valec = @8 Physical Haidware
Designer, you need to choose the [ || @ virr_ow

“‘VCWAVE_VARIABLES’ group in 2= Rl

WOWAVE_VARIABLE

the global variables worksheet. Desciptor: || & @8 cwave Mo

L | 3

| [ Show all variables of worksheet

™ POD [~ oPC

9 Virtual ControlWave User Manual



Since we want to get a combined total of . . . EDD
these two variables, we can use them as . P ——— P
. ; IO FLOW 22— —TIOTAL FLOW
input parameters to the ADD function T : : -
block. The result of adding them together RR_FLOWI1—
can be stored in the third variable called

TOTAL_FLOW, which is an output

parameter.

14. Now that the calculation has been created, compile the program as you normally would
using the Build-> Make command.

15. Now start the Virtual ControlWave program itself by clicking on Online - Virtual
ControlWave. (This is the *soft’ controller itself.)

16. After successfully compiling the

program, call up the Project Choose the correct resource, then click on [Connect]
Control dialog box, as you do 4 -

when you normally perform a . e |

download If your prOJeCt has RTU_RESOURCE Cwave Micro Oifline

more than one resource, the

dialog box may look different = 4 e e o | o |

than you are used to, because { D‘sc;mecq e | - | o | o |

you’ll be required to choose : = - - -

which resource you want to Loy | i |

download to, and connect to that resource.

In this case, you need to select the resource for the Virtual ControlWave. If you only
have one resource, the regular Project Control dialog box will appear.

17. Now download your project and initiate a cold start. Remember, we’re not downloading
it into a real ControlWave controller, we’re downloading it to a Virtual ControlWave
controller running on your PC using the IPC_40 resource, with its special settings.

NOTE: If you want to the downloaded project to start automatically every time you run the
Virtual ControlWave, be sure you select the bootproject to be part of the download.

Once the calculation is running in the Virtual ControlWave, the results of the total flow
calculation will be regularly updated within the OpenEnterprise Database. You could trend
them, include them on a display, etc.

To see the current value of the variables you brought in via the Virtual ControlWave

Configuration Tool, you can enter ‘Debug’ mode in ControlWave Designer, or you can view
them in the Virtual ControlWave Statistics Tool.
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You can now close down ControlWave Designer, if desired. The Virtual ControlWave will
continue to run and perform calculations on its own.

The Statistics Tool starts automatically when you download the project. To bring it

into view, click on the icon, shown at right, in the System Tray at the bottom of your ﬂl

screen.

Number of Virtual 1/0O Points
to the OE Database that
are currently configured.

|1, Virtual Control Wave Variable Statistics

=101

=43 AllVariables Hame

| Addre\e

| Walue

[ Type

724 By Name JD_FLOW?2
4 By Type RR_FLOW/1
& Byl TOTAL_FLOW

'@ Search Results

—Refresh every, ————————
|1 Second 'I Refrash |
i Search far name beginning with: —
Marne 2 Search

| O] e [ |

. | 3/ 5000

D0
xlD4
ZOD0

24.293333
13.400000
43693357

REAL
REAL
REAL

b A

Maximum Virtual I/O Points
allowed under this license.
Will display 2000, 5000, or

no value. If no value, indicates
no restriction other than avail-
ability of system resources.
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Application Notes

Including the Virtual ControlWave as part of your OpenEnterprise Session

Most OpenEnterprise users will find it
convenient to include the Virtual ControlWave
as part of their OpenEnteprise Session. This
ensures that the Virtual ControlWave is running,
and performing calculations, whenever the
OpenEnterprise Database is running.

In the Session Manager, choose Add = Task.

Use the [Browse] button to locate pcwin32.exe
in your Open BSI MWT folder, then click on
[Next>] to move through the various pages of
the Session Manager, accepting defaults each
time. Finally, click [Finish] and the Virtual
ControlWave will now be part of your session.

Locate 'pcwin32.exe' in your Open BSI MWT folder.
This is the Virtual ControlWave.

/XL

r Identification

Type the name used to identfy the task in the Session Manager.

Name: |Vitual ControlWave
~ Task /

Select the program to run and specify any ram arguments

Program

IC."'-OpenBSI"-m'f'\'l"'-uc'f'.'in32.3.!.3 - Browse... |

Run program in the following folder:

IC."'-OpenBSI"-m'f'\'l| Browse... |

Program Anguments:

[ atabase ready port [enter the port name or port numbern g, rdbl ]

< Back I Meat > I Cancel Help |

NOTE: Most users choose to have the Session Manager run the Virtual ControlWave as a critical
task, which restarts the Virtual ControlWave automatically following a failure. This is also the

default setting. For this to work properly, however, you MUST have downloaded the bootproject
to the Virtual ControlWave; otherwise the Virtual ControlWave will have no project to run when

restarted after a failure.

NOTE: Since the OPC Server is also required for the Virtual ControlWave to operate, you may
want to add a task for it in the Session Manager, if it isn’t configured to run automatically. This
would be configured similarly to the way you did for the Virtual ControlWave. The default path

for the OPC Server is:

C:\Program Files\BristolBabcock\OpenEnterprise\Bin\BristolOPCServer.exe

Using Lists in Your ControlWave Project to Improve Performance

The very first time an input from the OE Database is used in the program, there can be a slight
delay as the OPC server initializes the OPC tag.Using a list in your ControlWave Designer
program for your Virtual ControlWave inputs will help your program run better. Initializing the
list on Cold start will cause the values of the database signals to be instantly available to your
program at run time. When your global Virtual ControlWave variables are included in a list, they
are refreshed at start up and in the background as the program runs. There is no pause for
initialization the first time a value is requested from the database. See the LISTxxx and
DBLOAD sections of the ControlWave Designer ACCOL3 Function Block online help, for

more information on working with lists.
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Using the Same OE Database Signal as both an Input and an Output

A signal from the Open Enterprise Database may be defined as an input or as an output when
using the Virtual ControlWave Configuration Tool, but you may not use the same OPC Tag as

both an input and an output.

Sometimes, though, you may have a calculation in which you want to use the same signal as both
an input and an output. To accomplish this, one OPC tag can come from a ‘view’ of a table, and

another tag can come from the table itself.

For example, “Input” has been selected as
the type for this signal, and the IEC1161
name has been changed from the default
“vdig_102_value” to “vdig_102_in” to
denote that it is mapped as an input. This
tag references the “digital’ view.

Now, to use the same signal as an output,
we need to use a different OPC Tag that
points to the same signal. In this case we
are referencing the ‘digital_table’, NOT the
‘digital’ view. This ensures that we have
two separate OPC tags, even though they
are both referencing the same signal in the
OE Database.

%]

Edit Yariable

" ariable Mame: wdig_102_in
[ Chuality (%) [nput ) Output

BriztolB abcock. BrigtolDPCS ervert ttrdb 1", 'digital'.'name: charwdig_10
2" "valuebool

Edit Variable X
Yariable Mame: | vdig_102_out
) Input (%) Output

BriztolB aboock. BrigtalOPCS ervery rdb1" 'digital_table". " hame: charwd
ig_ 102" "value:boal”

You will now have 2 different ControlWave Designer variables that are connected to the same
OE Database signal. One may be used an input from the OE Database and the other as an output
to the OE Database from your ControlWave Designer project.

This same approach may be used for any of the tables and views in the database that contain

common signals, for example:

realanalog and nw3000realanalog
nw3000realanalog and nw3000realanalog_table

localrealanalog and realanalog

etc...
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Inputs and the OPC Quality Flag

When you designate a signal to be an input in the Virtual ControlWave, you have the option of
including the OPC Quality Flag. When you save the Configuration, a BOOL variable will be
added to your VCW Global Variables for each input that includes the quality flag.

The name of this Quality BOOL will be the input signal’s name with the suffix “_Q”.

For example, if the input signal was named vdig_1_in, and we included the OPC Quality Flag
for that signal in the Configuration, after saving we would have 2 ControlWave Designer
Variables: One will be the Input from the database (vdig_1_in) and the other one will be the
BOOL Quality variable (vdig_1 in_Q).

If the quality of the input from the OPC Server is good, the value of the quality BOOL will be
FALSE. If the quality of the input is other than good, the value of the quality BOOL will be
TRUE.

vdig_1_in quality = Good
vdig 1 in_ Q value = FALSE

vdig_1 in quality = Bad
vdig_1 in_Q value = TRUE

Limitations on the Number of Signals (Points) in the Virtual ControlWave Project

Although the Virtual ControlWave license allows for 5000 points, this may not achievable for
all Data Types. The total PDD memory available in a Control Wave Designer Program is 64 kb.
Refer to the chart below to determine the memory requirements for your signal quantities.

Memory Used by Data Type:
BOOL.: 1 byte
INT: 2 bytes
DINT: 4 bytes
REAL.: 4 bytes
STRING: 85 bytes

Things to remember:
e DATETIME values from the database will be treated as STRING
e INTEGERS values from the database will be treated as DINT
e When using OPC Quality for an input, an extra BOOL will be assigned,
using 1 additional byte.
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Appendix A

Creating Local Signhals in OpenEnterprise

What is a Local Signal?

Most of the time, we’re concerned with bringing data from RTUs and storing it in the OE
Database. Because those signals originate from remote process controllers, they are referred to as
remote signals, or RTU signals, etc. Sometimes, though, it can be useful to create a signal that
only resides in the OE Database, i.e. a local signal. Local signals are often used to store results
of calculations that come from more than one RTU.

For example, you might have three RTUs that are measuring flow, and you need to have a signal
that reports the total flow from all three RTUs. You can create a calculation in the Calculation
Server or the Virtual ControlWave that adds together the flow from each RTU, and stores it in a
local signal in the OE Database.

Creating a Local Signal Using the SOL Client

1) Start the SQL Client:

Start->Programs—->OpenEnterprise->Database>SQL

2) Enter the following statements in the SQL Client:
insert into localtablename (hame,regionname,devicename) values

("signalname™,"","");
commit;

where localtablename is the name of the table in the database that will hold the
local signal. Typically, this would be ‘localrealanalog’ or
‘localdigital’.

signalname is the name of the local signal.

For example:

insert into localrealanalog (name, accessarea, regionname, devicename)
values (‘TOTAL_FLOW’,’ALL’,”",”"):
commit;

NOTE: We don’t need to enter values for regionname and devicename when creating
a local signal.
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Appendix B

Virtual ControlWave Configuration Text File
(VCWCFG.PLC)

When you use the Virtual ControlWave Configuration Tool to add database signals to your
Designer project, the tool is actually creating and editing a configuration file called
VCWCFG.PLC which resides in the RTU_RESOURCE folder of your ControlWave project.

By default, the path for this file is:
C:\OpenBSI\Projects\ProjectName\C\ControlWave\R\RTU_RESOURCE\VCWCFG.PLC

If necessary, you may create or modify this file manually or programmatically. This is useful
when you don’t want to drag and drop every signal into the Configuration Tool window from

Database Explore. For example, if you want to add a large number of signals, it could be very
time consuming to add them one at a time.

Configuration File Format:

The first line in the file must be:

Each subsequent line represents one global Virtual ControlWave signal and has the following
format. Each field on the line is dilineated by a Tab character.

Variable_name OPC _tag Quality_flag Input_Output_flag
where:
Variable_name is the name of the Virtual ControlWave variable in your ControlWave

project. For example, vdig_1 in.

OPC_Tag is the text of the OPC Tag in the OPC server, for example:
“BristolBabcock.BristolOPCServer\"rtrdb1"."digital"."name:char:vdig_1"."value:bool"

Quality _flag will be 0 for Outputs or for Inputs that do not use a quality flag. It will be
1 for Inputs that use the quality flag.

Input_Output_flag  will be 1 for an Input or 0 for an Output.
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The sample file, below, shows all signals configured as inputs without the quality flag:

File Edit Format

pdig 1000 _in
wdig 1001 _dn
wdig 1002 _in
wdig 1003 in
wdig 1004 _dn
wdig 1005 _in
woig 1006 _in
wdig 1007 _in
wdig 1008 _in
wdig 1009 _dn
wdig_100_in
wdig 1010 _in
wdig 1011 _dn
wolig 1012 _dn
wdig_1013_in
wdig_1014_dn
wdig 1015 _dn

<

————— virtual Controlwave Configuration Tool File

B VowCfg. plc - Notepad

View Help

BristolBabcock. BristoloPcservery rtrdbl”. "digital” rcharrvdig_ 000" thool”
BristolBabcock. Bristolopcservery "rirdbl". "digital scharivdig 1001 thool”
BristolBabcock.Bristolopcservery'rirdbl". "digital ichar:vdig_ 1002 :bool”
BristolBabcock.BristoloPCservery " rtrdibl digital rchar:vdig 1003 thool”
BristolBabcock. Bristolopcservery"rirdbl". "digital schar rvdig 1004 thool”
BristolBabcock. Bristolopcservery rordbl”. "digital” scharsvdig 1005 thool”
BristolBabcock.BristolopCservery 'rirdbl”. "digital”. "name:char :vdig_1006". "value:hoaol”
BristolBabcock.BristoloPCServery'rirdbl”. "digital”. "name:char :vdig 1007". "value:hoaol”
BristolBabcock. Bristolopcservery"rtrdbl". "digital”. "name:char :vdig_1008". "value:hool"
BristolBabcock. Bristolopcservery'rordbl". "digital”. "name:char :vdig_1009". "value:hool"
BristolBabcock.BristoloPCservery'rordbl”. "digital”. "name: char :vdig_100". "value:bool"
BristolBabcock. Bristolorcservery "rtrdbl”. "digital”. "name:char :vdig 100", "value:hool"
BristolBabcock. Bristolopcservery rordbl”. "digital”. scharivdig 1011". "value:hool”
BristolBabcock. Bristolopcservery rordbl”. "digital” scharvdig1012". "value:hool”
BristolBabcock.BristoloPCservery'rtrdbl”. "digital” rchar:vdig 1013". "value:bool”
BristolBabcock. BristoloPcservery"rtrdbl”. "digital”."” scharivdig 1014". "value:bool”
BristolBabcock. Bristolopcservery"rirdbl". "digital”. "name:char :vdig_1015". "value:hool"

[=R=Y ol wlelal=lol= ool lel=y=l=)

CEX

FRERPRRERERERRERRERR R R

IMPORTANT

Once the configuration file has been created or
modified outside of the Virtual ControlWave
Configuration Tool, the Tool must be opened and
the configuration must be saved for the changes to
be saved to your ControlWave Designer Project.
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